Table of Contents

QUICK ACCESS TIP: To navigate directly to a specific section listed in the Table of Contents, hold down the CTRL key while clicking on the page number of that specific section.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION</td>
<td>5</td>
</tr>
<tr>
<td>GENERAL JIRVEN INFORMATION</td>
<td>5</td>
</tr>
<tr>
<td>INSTALLATION</td>
<td>5</td>
</tr>
<tr>
<td>New jIRVEN Installation Guide</td>
<td>5</td>
</tr>
<tr>
<td>INITIAL SETUP LOGIN</td>
<td>6</td>
</tr>
<tr>
<td>ACCESSIBILITY</td>
<td>6</td>
</tr>
<tr>
<td>jIRVEN User Roles</td>
<td>7</td>
</tr>
<tr>
<td>OPENING THE JIRVEN APPLICATION</td>
<td>8</td>
</tr>
<tr>
<td>ACCESS JIRVEN</td>
<td>8</td>
</tr>
<tr>
<td>All Programs – Start Menu</td>
<td>8</td>
</tr>
<tr>
<td>Desktop Icons</td>
<td>8</td>
</tr>
<tr>
<td>The Initial Splash Screen</td>
<td>9</td>
</tr>
<tr>
<td>Possible Error Message</td>
<td>10</td>
</tr>
<tr>
<td>LOGIN POP-UP WINDOW</td>
<td>10</td>
</tr>
<tr>
<td>Initial Setup Login (Default User Login Only)</td>
<td>10</td>
</tr>
<tr>
<td>jIRVEN User Roles - First-time Login AFTER Initial Setup</td>
<td>11</td>
</tr>
<tr>
<td>jIRVEN User Roles - Subsequent Logins</td>
<td>13</td>
</tr>
<tr>
<td>HOME TAB</td>
<td>14</td>
</tr>
<tr>
<td>Home Tab Default</td>
<td>14</td>
</tr>
<tr>
<td>Available Home Tab Hyperlinks by User Role</td>
<td>14</td>
</tr>
<tr>
<td>Navigating to the User Guide</td>
<td>16</td>
</tr>
<tr>
<td>JIRVEN ASSESSMENT VALIDATION &amp; DATA ENTRY</td>
<td>16</td>
</tr>
<tr>
<td>General Assessment Information</td>
<td>16</td>
</tr>
<tr>
<td>Data Entry Field Types</td>
<td>16</td>
</tr>
<tr>
<td>Data Entry Edits</td>
<td>21</td>
</tr>
<tr>
<td>jIRVEN User Tool Search</td>
<td>21</td>
</tr>
<tr>
<td>Initiate the Search</td>
<td>22</td>
</tr>
<tr>
<td>Use No Criteria</td>
<td>22</td>
</tr>
<tr>
<td>Use Specific Criteria</td>
<td>22</td>
</tr>
<tr>
<td>Search Summary Result</td>
<td>23</td>
</tr>
<tr>
<td>Administration Data (Administration Screens)</td>
<td>24</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>24</td>
</tr>
<tr>
<td>Administration Screen Tabs</td>
<td>24</td>
</tr>
<tr>
<td>FACILITY SCREEN – ADD &amp; MAINTAIN A FACILITY</td>
<td>26</td>
</tr>
<tr>
<td>FACILITY SCREEN – CREATE A FACILITY</td>
<td>26</td>
</tr>
<tr>
<td>FACILITY SCREEN - MODIFY A FACILITY</td>
<td>28</td>
</tr>
<tr>
<td>FACILITY SCREEN - DELETE A FACILITY</td>
<td>28</td>
</tr>
<tr>
<td>FACILITY SCREEN – SPECIAL FUNCTIONALITY</td>
<td>29</td>
</tr>
<tr>
<td>Effects of Modifying the Facility</td>
<td>29</td>
</tr>
<tr>
<td>USER SCREEN – ADD &amp; MAINTAIN A USER</td>
<td>29</td>
</tr>
<tr>
<td>USER SCREEN - CREATE A USER</td>
<td>30</td>
</tr>
</tbody>
</table>
# JIRVEN APPLICATION REPORTS

- **Report Viewer**
- **Print Report**
- **Save Report**
- **Export Report**
- **Available Reports**
  - **Event tracking Reports**
- **Assessment Data Entry – By Status Report**

# Closing the Application

- **Session Time Out**
- **Logout**
- **Exit**
- **Data Backup on Close**

# Security

- **Change Security Answers**
- **Change Password**

# Help

- **Help Options from Menu Bar**
- **Help Search**
- **Help Contents**

# About Quality Management System

- **QIES Help Desk**
- **Feature Verification**

# Home Screen

- **Password Rules**
- **Forgotten Passwords**

# Misc. System Maintenance

- **Locked User Accounts**
  - **Data Entry User & View Only User Account Locked**
  - **System Administrator Account Locked**
- **Database Backup**
  - **Changing the Backup File Location**
  - **Restore the Database from Backup**
- **Unlock Network Client/Server Records**
  - **Unlocking an Assessment from the Assessment Search Screen**

# End of JIRVEN User Guide
Introduction

The Centers for Medicare and Medicaid Services (CMS) sponsored the development of the Inpatient Rehabilitation Validation and Entry (IRVEN) system. jIRVEN is a Java-based data entry system for Inpatient Rehabilitation Facilities (IRFs). jIRVEN offers users the ability to collect the IRF Patient Assessment Instrument (IRF-PAI) in a database.

The jIRVEN application displays the IRF-PAI similar to the paper version of the form. Once data collection is completed, facilities are able to export their data from the application and submit it to the appropriate national data repository.

The data collected is used for assessing the clinical characteristics of patients in rehabilitation hospitals and rehabilitation units in acute care hospitals. The data will provide survey facilities with a means to objectively measure and compare facility performance and quality. It will also provide researchers with information to support the development of improved standards. The data entry software imports and exports data in standard CMS record format. The software maintains facility and patient information, enforces data integrity via rigorous edit checks, and provides comprehensive online help. It includes a data dictionary and a grouper calculation.

The jIRVEN version number is displayed on several screens in the application. In this document, the version number is documented as 1.x.x

For more detail, go to the CMS website using the QTSO link:

- https://www.qtso.com/irven.html

Or the direct hyperlink to CMS:

- http://www.cms.gov/Medicare/Medicare-Fee-for-Service-Payment/InpatientRehabFacPPS/IRFPAI.html

jIRVEN is designed to work with external screen reader software (e.g., JAWS) for compliance with Section 508. At the login screen, users have the checkbox option to select “Enhanced Accessibility Feature”. This option should be checked when an external screen reader will be used. This option also controls the availability of some jIRVEN functions. If a function only exists when enhanced 508 compatibility is checked, then it will be described as available only in 508 mode. If a function only exists when “Enhanced Accessibility Feature” is unchecked, then it will be described as available only in non-508 mode.

General jIRVEN Information

Installation

jIRVEN may be used as a standalone application or in a network configuration.

- A standalone installation is used on an independent user workstation.
- A network installation is intended to be used for a group of users with a designated database server in a separate location.

New jIRVEN Installation Guide

Installation instructions are located in the “jIRVEN Installation Guide”. The Installation Guide should be on the User’s desktop or it can be found in the following websites:
• The CMS Websites:  http://www.cms.gov/Medicare/Medicare-Fee-for-Service-Payment/InpatientRehabFacPPS/Software.html
• The QTSO Website: https://www.qtso.com/irven.html

**Initial Setup Login**

For initial login, using the default User ID, please consult the jIRVEN Installation Guide. That is the guide, which details the Software Installation and the Initial Setup Login process.

After the initial Login is completed, the default user must add a facility and the first System Administrator. See the following sections in this Guide: Facility Screen – Add & Maintain a Facility and User Screen – Add & Maintain a User.

**Accessibility**

Selecting the ‘Enable Accessibility Features’ check box at the bottom of the login screen will turn on accessibility features for users requiring assistive technology (e.g. screen readers).

By default, the ‘Enable Accessibility Feature’ check box will be checked the first time the Login pop-up displays, after the installation has been completed successfully.

![Accessibility Features](image)

The check box will remain checked, or unchecked, until changed by the user when the user logs into the application again.

![Accessibility Features](image)

If the user chooses to use the accessibility features, the Accessibility icon will display in the tool bar on screens within jIRVEN. The user can either click on the icon or use ALT+J to open the accessibility screens.
The initial ‘Home’ pop up window explains briefly how to use the accessibility feature. Each screen also has an initial pop-up window to explain the layout of that specific screen and provide shortcut keyboard combinations to move the cursor around the page. For example, ALT+1 on the Facility screen will move the cursor to the beginning of the facility data entry section. When the cursor is on an arrow beside a field, the space bar will expand/collapse a section of data.

NOTE: When using key combinations such as ALT+1, the numbers across the top of the keyboard should be used rather than the numeric keypad.

**jIRVEN User Roles**

The User Roles available in jIRVEN include:

- System Administrator
- Data Entry
- View Only

The specific User Role assigned to a user determines what functionality is available to that user.

To enhance security of data in the application, each user type has a different level of access.

The following table, User Roles Access Table, provides a summary of the different user roles and their access rights within the jIRVEN tool. Access is listed by Menu Options based on which screen is active. It also lists the hot keys available.

**User Roles Access Table**

Table legend:

- Yes = User will see this option and have access to it.
- No = User will see this option, but will not have access to it.
- ‘-’ = User will NOT see this option; therefore, will not have access to it.
- N/A = Option does not have a representative icon

<table>
<thead>
<tr>
<th>jIRVEN</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>Sys Adm</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu (no Active Screen)</td>
<td>Alt+F</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Administration Menu</td>
<td>Alt+A</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Import/Export Menu</td>
<td>Alt+I</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Reports Menu</td>
<td>Alt+R</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Security Menu</td>
<td>Alt+U</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Assessment Menu</td>
<td>Alt+M</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Help Menu</td>
<td>Alt+H</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

¹ Alt Keys are valid only if that user has access to that function.
² If available to user as a menu option, then icon will appear in users tool bar. If not available to user in the menu options, the icon will not appear in the users tool bar.
Opening the jIRVEN Application

Access jIRVEN

Once jIRVEN has been installed and the ‘initial setup’ has been successfully completed, access the program using one of the following methods.

All Programs – Start Menu

Complete the following steps to open the jIRVEN application using the All Programs – Start Menu

1. Click on the Windows Icon in the very lower-left hand corner of the screen.

2. Click on the ‘All Programs’ button.

3. This will display the program tree; lists the applications on the machine.

4. Locate the Folder for jIRVEN, or jIRVEN Client, depending upon which was installed and required.
   a. Click on the folder needed.
   b. Select the acronym of the application needed.

5. The Application will open with the jIRVEN Splash Screen.

Desktop Icons

Complete the following steps to open the jIRVEN application using the Desktop Icons placed on the desktop during Installation.

1. Double click on one of the following Icons.
IMPORTANT NOTE: Only one of these ICONs will be on the desktop. Either ‘jIRVEN’ for the standalone version or ‘jIRVEN Client’ for the network client/server version.

The Initial Splash Screen

The jIRVEN splash screen is the first screen displayed when initiating the application. This may take a few minutes.

The ‘Welcome to jIRVEN’ screen displays while the program is loading. This may take a few minutes and requires no response from the user.
Possible Error Message

Only one copy of each type of installation of jIRVEN may be running at one time. If the Standalone application is running, it cannot be re-launched. The same is true of the Client/Server application.

Also, only one type of the application can be run at one time. That is, if the Standalone type of the application is run, the Network Client/Service type of application cannot be launched.

Login Pop-up Window

The title bar of the login screen will include the User Tool acronym (jIRVEN) and software version number (1.x or 1.x.x). Accessibility can be turned off on this pop-up window by removing the check in the checkbox. If the check is left, then Accessibility will be turned on.

This pop-up Login window contains:

- User ID field
- Password field
- Login button
- Cancel button
- Forgot Password button
- Enable Accessibility Features check box

Initial Setup Login (Default User Login Only)

“IMPORTANT INSTRUCTIONS: For the initial ‘setup’ login, the default User ID of “jirven” (case sensitive) must be used. The default password of “jirven” (also case sensitive) must be used.

This is documented in detail in the jIRVEN Installation Guide.”
jIRVEN User Roles - First-time Login AFTER Initial Setup

The ‘default user’ MUST successfully complete the initial setup of the application before any other user can login. This is outlined in detail in the Installation Guide.

Complete the following steps to login to jIRVEN for the first time after the Initial Setup is successfully completed.

1. Enter the User ID assigned by the System Administrator user, in the User ID field.
2. Enter this same assigned User ID into the Password field.
3. Accessibility
   a. If accessibility is required, use the default provided; the ‘Enable Accessibility Features’ check box.
   b. If Accessibility is not required, the user may uncheck the check box.

   IMPORTANT NOTE: The User ID and Password are case sensitive.

4. Click Login.
5. The Change Password screen displays.

   ![Change Password Screen](image)

   6. Enter a new password in the New Password and Confirm New Password fields. The password is case sensitive and must match in both fields. The following rules are displayed at the top of the Change Password screen:
      b. “The new password must be at least 8 characters long.”
      c. “The new password must be no more than 20 characters long.”
      d. “The new password must not contain any space.”
      e. “The new password must not contain the User ID, First Name, Last Name, or Email.”
      f. “The new password must not begin with a number.”
      g. “The new password can only contain a maximum of 3 repetitive characters.”
      h. “The new password must contain at least one for each of the following type of characters.”
i. “Upper-case Character: A-Z”
j. “Lower-case Character: a-z”
k. “Number: 0-9”
l. “Special Character: - &~’!@#$%^*()_+={}|\:";'<>?,.?/”
m. “The new password must not match any of the user’s most recent 6 passwords.”
n. “The new password will be set to expire in 60 days.”

7. Click the ‘Continue’ button to complete the login process. The Security Window is displayed.
   a. If the ‘Cancel’ button is clicked instead of “Continue”, then a pop-up window is displayed with the message, “You must change your password before accessing the system. If you do not change password, you will be logged off the system”.
      i. From this message window, the user may click ‘OK’ and return to the Login pop-up window.
      OR
      ii. The user may click ‘Cancel’ and return to the Change Password window.

8. The Security Questions screen displays. “It is required that the user respond to at least six (6) of the ten security questions listed.”

   a. “What city were you born in?”
b. “What year did you graduate from high school?”
c. “What is your favorite sport?”
d. “What was the make of your first car?”
e. “What was the color of your first car?”
f. “What is your mother’s maiden name?”
g. “What was the name of your first pet?”
h. “What size shoe do you wear?”
i. “What is your favorite season of the year?”
j. “What is your favorite movie?”
Note: The user must tab forward after entering their last answer, in order to enable the “OK” button.

9. Click ‘OK’.
10. The jIRVEN screen displays.

**jIRVEN User Roles - Subsequent Logins**

Complete the following steps to login to jIRVEN if this is NOT the first time doing so AND you have setup your password successfully.

1. Enter the User ID assigned by the System Administrator, in the User ID field.
2. Enter the Password you have created into the Password field.

   **IMPORTANT NOTE:** The User ID and Password are case sensitive.

3. Click ‘Login’.
4. The jIRVEN screen displays.
5. When the user has successfully logged in, the application screen displays will become available based on User Role using the Menu items.
   a. System Administrator will have access to File, Administration, Import/Export, Reports, Security, Assessment, and Help.
   b. Data Entry User will have access to File, Administration, Reports, Security, Assessment, and Help.
   c. View Only User will have access to File, Reports, Security, Assessment, and Help.
IMPORTANT NOTE: The specific User Role assigned determines what functionality is available to that user.

Home Tab

The first screen to be displayed is the jIRVEN Application Welcome screen. The first time a user logs into the application, the Home tab will be displayed. This is dynamic based on the User’s assigned User ID.

Home Tab Default

At the bottom of the Home tab, there is check box with the instruction statement: “Do not display this home screen after logging into the application”. The default is for the check box to be unchecked, indicating the user will have the Home Tab displayed...

However, the User may:

- Close the tab, which will cause it NOT to be displayed again during this session.
- Or, they may chose NOT to use the Home tab in later sessions. To stop the Home tab from displaying, the user must check the check box.

IMPORTANT NOTE: The Home tab setting remains unchanged for each User ID until the user changes it using the check box. This is true even when the software is upgraded; the setting will remain the same.

Available Home Tab Hyperlinks by User Role

This Home Tab is unique to each User ID. That is, each user has access to their personal settings.

System Administrator

The System Administrator will have access to:

- The “Go To” action buttons: Facility, User, Patient, Assessment Search, Import/Export, Event Tracking Reports, Assessment Data Entry Report by Status, and jIRVEN User Guide.
Default User
The default user will have access to:
- The “Go To” action buttons: Facility, User, and jIRVEN User Guide.

Data Entry User
The Data Entry User will have access to:
- The Menu items and their drop down option: File, Administration, Reports, Security, Assessment, and Help.
- The “Go To” action buttons: Facility, Patient, Assessment Search, Event Tracking Reports, Assessment Data Entry Report by Status, and jIRVEN User Guide.

View Only User
The View Only User will have access to:
- The “Go To” action buttons: Assessment Search, Assessment Data Entry Report by Status, and jIRVEN User Guide.
Navigating to the User Guide
When the ‘Go To User Guide’ button is used, the .pdf copy of the User Guide for jIRVEN is open and displayed.

If the application cannot find the User Guide where it is expected, the following error message displays.

1. Click the ‘OK’ button.
2. Contact your System Administrator.

jIRVEN Assessment Validation & Data Entry

General Assessment Information

Data Entry Field Types

Text
Text fields allow data to be entered manually, which adheres to the submission rules (length, special characters, etc.) for the specific field. The following are examples of a text fields taken from the screen.
There are text fields, which require specific formatting. If the user enters an incorrect format, an error message displays.

**Date**

Date fields are formatted for the entry of a valid date. The date may be entered manually or by clicking on the calendar next to the date field and selecting a date. Format must be in MM-DD-YYYY format using a valid calendar month.

Where: MM = 01-12, DD = 01-29, 30, or 31, depending on the month, and YYYY equals the four digit year.

The following is an example of a date field.

NOTE: The calendar icon will only be displayed when the 508 accessibility is unchecked; turned off.
Check Box
Check boxes allow the selection of values listed with each check box. If the check box is checked the value will be included. If not checked, it will not be included. The following is an example of this type of check box.

Examples of the available selections for check boxes for the “Race/Ethnicity (9)” field are:
- (A) American Indian or Alaska Native (A)
- (B) Asian (B)
- (C) Black or African American
- (D) Hispanic or Latino
- (E) Native Hawaiian or Other Pacific Islander
- (F) White

The user may select one or more of these check boxes, unless otherwise stated. The User may also uncheck boxes previously checked so as not to include them in the selection process.

Numeric Field
Numeric fields, which allow a user data entry, usually require specific formats. If the user enters a number in an incorrect format, an error message displays.

Drop Down List
Drop down lists contain allowable ‘fixed’ selections to a specific field. To enter data from a drop down field, tab to the field and use the arrow keys on the keyboard to navigate through the selection options. Once the appropriate selection is displayed, use the Tab key to move to the next question.
A mouse may also be used to select an answer in a dropdown list. Click the arrow on the right side of the field to expand the list. Click the desired answer. Click the mouse on the next question. The Delete key on the keyboard can be used to clear the field.

The following is an example of a dropdown list for the State Code. Item listed in the sample below are:

- Iowa
- Idaho
- Illinois
- Indiana
- Kansas

![Dropdown List Example](image)

**List Box**

A List Box is a display-only box that the application populates. The first row will contain the field name. The remaining row(s) will be populated with data selected by the User. If multiple selections are allowed and are selected, they will be listed one below the other in a list.

![List Box Example](image)

These List Boxes are most often associated with Grid fields.

**Grid**

Grid buttons are used for selection of one or more values. Click on the grid button and the user will have a series of pop-up windows containing a list of items from which to choose. The user may select one or more of these items following the available actions in the menu.

![Grid Example](image)

The Grid opens up to an empty selection list. The ‘New’ ICON will add a row if more than one row may be added to the field. The box displaying three dots, on the right end of the first row, will display
a list of all appropriate diagnosis codes, from which the user may select. When the OK button is selected the ICD code selected will be displayed on the list. The Cancel button will close this pop up and any selected ICD code will not be displayed.

NOTE: If multiple diagnoses are selected they will all be listed in the List Box. Once the system reads a blank line, it assumes the list is complete and stops reading the list.

The user may then insert their selection. Select a different diagnoses, verify, and close the pop-up.

The jIRVEN application will then place the selected value into the List Box, which is a display-only field. The selection shown in the list box for field “22. Etiologic Diagnosis” is “V90.89 Other Specific Retained foreign body”.

This box will be expanded to accommodate multiple selections.

If the user wishes to modify this selection, they can select the Grid button and repeat the process.
Data Entry Edits

Edits
Data edits are applied to the fields during the data entry process into jIRVEN.

NOTE: These edits are unique messages in place to assist users with the accurate completion of data entry. Some will present a pop up message and must be addressed at the time they are displayed in order to proceed. Some edits may not appear until the entry is saved & validated.

The error messages are assigned numbers to aide in trouble shooting. When there are questions about a message, it is beneficial to record the message before calling the Help Desk. This can facilitate quicker answers and/or resolutions.

Error Messages
This type of edit message lets the user know information entered is incorrect or missing. It must be corrected or entered before the information will be saved. May be referred to as a “fatal” error. This example is the Error list of some of the fatal facility errors:

- 10017 Facility Name (1A) is required.
- 10018 Facility Address Line 1 is required.
- 10019 Facility City is required.
- 10020 Facility State Code is required.
- 10022 Facility Medicare Provider Number (1B) is required.
- 10023 Facility Contact Person is required.

The "X" symbol identifies this message as a Fatal Error Message.

Other Message Types
The following symbols are used for other messages types. The “!” symbol identifies this message as a Warning Message. The “?” symbol identifies this message as a Decision Message. The “I” symbol identifies this message as an Informational Message.

jIRVEN User Tool Search

IMPORTANT NOTE: You may experience increased wait time when searching for a large number of Residents due to database encryption.

The search feature is available for the following:
- Assessments
- Patients

All these search features function in the same manner. The difference is in how they are initiated.
Initiate the Search

Assessment Search

Select the Search option from the Assessment drop down on the Menu Bar and the Assessment Search Screen displays.

The Assessment Search screen displays.

Patient Searches

There is a search feature for the Patient Screen within the Administration screens. Select the Patient option from the Administration drop down on the Menu Bar and the Patient Screen displays. The Search section is in the first section of this screen.

Use No Criteria

1. If no criteria are to be used, move past the Search Criteria rows, and click the Search button.

2. All the Records found in the database will be returned. The exception would be any Patient or Assessment associated with a Patient marked as “Yes, Hide Patient”. These will not be included.

Use Specific Criteria

1. If specific criteria can be used to narrow the search, add it into the Search Criteria rows using Field Name, Condition, and Field Value

   a. Text Fields:
      i. Fields requiring the User to enter data into the Field Value.
      ii. Conditions for Text fields will be: Contains, Equal To, and Not Equal To.

   b. Fixed Value Fields:
      i. Fields requiring the User to select an option for a dropdown for the Field Value.
      ii. Conditions for Fixed Value fields will be: Equal To and Not Equal To.

   c. Date Fields:
      i. Fields requiring the User to enter a date into the Field Value.
ii. Conditions for Date fields will be: Equal To, Greater Than, Equal To or Greater Than, Less Than, Equal To or Less Than, and Not Equal To.

RULES:
1. If one of the criteria fields is used, all three (3) criteria fields (Field Name, Condition, and Field Value) must be used.
2. Text fields and date fields will require the user to enter data into the Field Value field.
3. Fixed value fields will require the user to select a value from a drop down list.

2. Click the Search button.

NOTE: Clicking the Search button after entering the search criteria will display only the results that match all the search criteria.

Other Search Options
‘Clear’
Click the ‘Clear’ button to remove all search criteria.

‘Show Hidden’
User may request to see all the items that have been hidden by placing a check in the ‘Show Hidden’ check box. The Result will include assessments for all Patients marked “Hide Record”. Unchecking this box will eliminate all Patients that have been hidden.

Search Summary Result
The results of the search, whether or not criteria were used, display all the results found, 100 records per page. This summary is sorted by the Patient’s Last Name.

The User may re-sort the summary by clicking on the column headers. In the following example, the summary has been sorted by the ‘Social Security Number’ column.

Navigating the Search Result Summary
Arrow buttons are provided to navigate the Search Summary section.

Only One Page Required for Results
If there are 100 or fewer records in the result, then navigating the Search Summary is not required. All records will be sorted and displayed on only one summary page. The arrow keys will be disabled.
More than One Page Required
If more than 100 records are found, each 100 records will be sorted as one unit and displayed in the summary. The Arrow buttons are enabled and used to navigate the summary:
   a. Return to the first page displaying the first 100 records.
   b. Go back one page.
   c. The total number of records returned ‘of 14’ and which records are currently displayed in the summary ‘(1-14)’.
   d. Go forward one page.
   e. Go forward to the last group of 100 records displayed on the last page.
   f. View All (may need to use scroll bar)

Administration Data (Administration Screens)
Before any assessments can be created, a basic set of administration data is required. This data consists of Facility data, User data, and Patient data. It is entered into jIRVEN via the Administration Screens. The Facility, User and Patient data will support the Inpatient Rehabilitation Admission & Discharge Assessments.

Tool Bar
Each screen contains a tool bar that displays various buttons and icons to assist the user. Holding the mouse over the icons will display the name of the functionality. The availability of the icons will vary depending upon the user role and the Administration screen displayed (active).

Administration Screen Tabs
Tabs for any open Administration screens will display. An asterisk (*) next to the name on the tab means there are changes that need to be saved.

Various screens are divided into multiple sections. Sections displayed are dependent upon the type of screen.

The Facility screen is divided into:
   • Facility Summary
   • Facility (Detail)
The User screen is divided into:
- User Summary
- User Detail
- Activation Detail
- Provider Detail

The Patient screen is divided into:
- Search Criteria
- Patient Summary
- Patient (Detail)
- Actions

Each section can be collapsed, as illustrated in the above screen shots, by use of the arrow to the left of the section title. Clicking on the arrow a second time will expand the section.

Some sections may also be resized if needed by placing the cursor over the line that separates the sections. The cursor will create an arrow. Click and drag the line to either the right or left depending on which area the user wants to expand. Columns in the Summary section can be resized by clicking and dragging on the line between headings.
Facility Screen – Add & Maintain a Facility

The System Administrator and the Data Entry User have access to the Facility screen.

NOTE: The default user also has access to this administration screen, which they primarily use to complete the Initial Setup.

Facility Screen – Create A Facility

For optimization of the skip patterns and/or edits, it is recommended that data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

The Facility screen allows users, to setup, modify and delete facilities. Complete the following steps to create a new Facility.

1. Select the Facility option from the Administration drop down on the Menu Bar.

2. The detail panel of the Facility Screen is on the right side of the screen. Enter detail facility information into the appropriate fields.

3. Required fields display on the screen in bold type with an asterisk (*).
   a. Facility ID (required)
   b. Facility Name (required)
   c. Facility Address Line 1 (required)
   d. Facility Address Line 2
   e. Facility Zip Code
   f. Facility City
   g. State (required)
h. Facility Zip Code
i. Facility Medicare Provider Number (required)
j. Facility Medicaid Provider Number
k. Facility Contact Person (required)
l. Contact Person Phone
m. Phone Extension

3. After facility details are entered, click the Save icon.
   a. If Accessibility is on, The Save Facility Options pop-up window displays.
      i. “Save and Close”
      ii. “Save and Continue”
      iii. “Cancel”
   b. The Informational Message displays to confirm that the facility has been saved.

4. Saved facility information will display in the Facility Summary section on the left side of
   the screen. The columns in the Summary are:
   a. Facility Name
   b. Facility Address Line 1
   c. Facility Address Line 2
   d. Facility City
   e. State Code and State Name
   f. Facility Zip Code
   g. Facility ID
      i. Assigned by CMS
   h. Facility Medicare Provider Number
   i. Facility Medicaid Provider Number
   j. Facility Contact Person Name
   k. Phone Number
   l. Phone Extension
To continue on this screen and add additional facilities, click the new icon.

Enter data and click the Save icon.

NOTE: Edits are performed during the data entry process producing errors. If any of the errors are remaining at the time the Facility is saved, they are summarized in a pop-up window.

Facility Screen - Modify a Facility

Complete the following steps to modify an existing facility.

1. Locate and highlight the facility in the summary section.

2. Make the appropriate changes in Facility Detail section of the screen, which is on the right side.

3. Click the Save icon.

Facility Screen - Delete a Facility

Complete the following steps to delete a facility.

1. Locate and highlight the facility in the summary section.
2. Click the Delete icon.

RULES:
1. A Facility cannot be deleted if patients have already been created under that facility.

**Facility Screen – Special Functionality**

**Effects of Modifying the Facility**

The User may modify the Facility information in an existing Facility. When this is done through the Facility screen, the following activities occur within all the Administration Screens.

- Any User that has been associated with the original Facility ID will be re-associated with the NEW Facility ID and/or Facility Name.
- If there are patients associated with the original Facility ID, those Patients will be re-associated with the NEW Facility ID and/or Facility Name.
- If there are assessments associated with any patient that has been re-associated with any updated Facility fields, when these assessments are re-opened, a Decision Message will be displayed.

**User Screen – Add & Maintain a User**

The System Administrator has access to the User Screen.

NOTE: The default user also has access to this administration screen, which they primarily use to complete the Initial Setup.
User Screen - Create a User

There must always be at least one active System Administrator. It is highly recommended that there be at least two System Administrators.

The User screen allows users, based on their specific User Role, to setup new users, modify users and delete users. Complete the following steps to add a new user.

1. Select the User option from the Administration drop down on the toolbar.

2. The User screen displays.

3. Enter user information into the ‘User Detail’ section. Required fields display on the screen in bold type with an asterisk.

4. Enter the Activation Date in the ‘Activation Detail’ section. A Termination Date should not be entered when creating a new user.

5. Enter the Provider Detail. User must select a Facility to which this User will be associated.

   NOTE: The Data Entry and View Only User may only view those patients and assessments associated with the same Facility with which they are associated.

6. After user information has been entered, click the Save icon. Saved user information will display in the User Summary section on the left side of the screen.

7. To add additional users, click the new icon.
User Screen - Modify a User

Complete the following steps to modify an existing user.

1. Access the User Screen.

2. Locate and highlight the user in the summary section.
3. Make the appropriate changes under the ‘User Detail’ panel on the right side of the screen.
4. Click the Save icon.

NOTE: The User ID field cannot be modified once the user is saved.

Termination Date

A Termination Date should only be entered if an active user is no longer valid (e.g., no longer works for the facility).

IMPORTANT NOTE: If a Termination Date is entered, a Termination Date message box displays advising pending assessments will be reassigned to an active user.
User Screen - Delete a User

Complete the following steps to delete a user. Locate and highlight the user in the summary section.

1. Click the Delete icon.

RULES:
1. Deletions cannot be made if user has created or modified any assessments.

Patient Screen – Add & Maintain a Patient

The System Administrator and Data Entry Users have access to the Patient screen.

The Patient screen allows users, to add, edit, delete and search for Patients.
To access the Patient Screen select the Patient option from the Administration drop down on the menu bar.

Patient Screen – Create a Patient

Patients may be added to the jIRVEN application after the Patient ID has been assigned by the CMS State Facility and forwarded to the User. System Administrators and Data Entry Users may add Patient records. Complete the following steps to add a new Patient:
1. Display the Patient Screen.

2. The detail panel is on the right side of this screen. Enter Patient information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).
a. Facility Name (required)
b. Patient Medicare Number
c. Patient Medicaid Number
d. Patient First Name (required)
e. Patient Middle Initial
f. Patient Last Name (required)
g. Suffix
h. Patient Identification Number
i. Birth Date (required)
j. SSN
k. Gender (required)
l. Race/Ethnicity (required)
m. Hide Patient Record (available for System Admin only)
n. Marital Status
o. Zip Code Pre-Hospital Residence
p. Facility Document ID
q. Unit

3. After Patient information has been entered:
   a. Click the Save icon in the Tool Bar
   OR
   b. Click the ‘Save Patient’ option in the File drop down options

4. Saved Patient information will display in the Patient Summary section on the left side of the screen. This summary contains the following columns:
   
   c. Patient Last Name
d. Patient First Name
e. Patient Middle Initial
f. Suffix
g. SSN
h. Patient Medicare Number
i. Patient Medicaid Number
j. Birth Date
k. Race/ethnicity
l. Gender
m. Marital Status
n. Patient ID Number
o. Zip Code of Patient’s Pre-Hospital Residence
p. Unit
q. Facility Document ID
r. Facility Name
5. To add additional Patients,
   a. Click the New icon or the Add Patient button.
   b. Enter data and click the Save icon.

**Patient Screen - Search**

If a specific Patient, or set of Patients, is required, use the jIRVEN User Tool Search. For this search, go to [jIRVEN User Tool Search](#).

**Patient Screen - Modify a Patient**

If a specific Patient, or set of Patients, is required, use the jIRVEN User Tool Search. See the hyperlink above.

   IMPORTANT NOTE: You may experience increased wait time when searching for a large number of Residents due to database encryption.

Complete the following steps to modify an existing Patient.
1. Locate and highlight the Patient in the summary section.
2. Make the appropriate changes on the right side of the screen.
3. Click the Save icon.
4. The Patient data will be saved.

**Patient Screen - Delete a Patient**

Complete the following steps to delete a patient. Locate and highlight the patient in the summary section.
1. Click the Delete icon.
OR
2. Click the 'Delete Patient' button at the bottom of the screen.
3. If Accessibility is NOT turned on, the Patient will be deleted and the Patient Screen will be closed.
4. When Accessibility is turned on, the ‘Delete Patient’ Message pop-up displays, “Delete Patient. Would you like to delete the Patient?”
   a. Select the desired action button.
   b. Delete and Close
   c. Delete and Continue
   d. Cancel
5. If the Patient is deleted, a pop-up message will be display to indicate this delete was successful.

**RULES:**
1. A patient cannot be deleted if one or more assessments have been created for the patient.

If the Patient has an assessment:
   a. Pop-up Window displays. “Cannot Delete a Patient with one or more Assessments. You cannot delete the Patient <<Patient Name>> because they have the following assessment(s)”
   b. Includes a list of all assessments for that Patient.
      i. Admission Date
      ii. Discharge Date
      iii. Assessment Type
iv. Status
v. Assessor (User ID)
vi. Assessment Date
vii. Export Date
c. Click ‘Cancel’ button to close the pop-window. The delete will not occur.
d. The Patient screen will remain open.

Patient Screen – Special Functionality

Effects of Modifying Patient Data

The User may modify the Patient data on the Patient screen. If there are assessments associated with that modified patient, the next time the assessment(s) is opened, a Decision Message will be displayed.

1. The User must determine whether to allow the assessment to be updated with the new patient data, to leave the assessment as it is and use the original patient data.
   a. Yes = Update the assessment with the new data. Open the Assessment. Continue.
   b. No = Open the Assessment, but do NOT update the patient data. Continue.
   c. Cancel = Close this pop-up decision window. Do not open the Assessment. Do not additional processing.
2. The Patient screen will remain open.

Move a Patient from One Facility to Another Facility

The System Administrator has access to the functionality to move patients.

A patient is assigned to a facility via the Patient Screen. Each patient must be associated with a Facility at the time the patient is added into jIRVEN.

RULES:
1. To move a Patient from one Facility to another, all the existing assessments, created under the currently associated Facility, must be exported.

First review this patient’s assessments and export any assessments that have NOT been exported. Exporting details are outlined in the section Exporting Assessments for Submission into ASAP.

If there are non-exported assessments for the Patient, which the user wishes to move, the following message will display: “This patient has non-exported or incomplete assessments for this Facility with the Assigned Facility/Provider Submission ID ‘Facility Name <<Facility Name>> - <<Facility ID>>. Complete or export all existing assessments for this patient then change the Assigned Facility ID.””
Complete the following steps to move a patient from one facility to another facility.

1. Open the Patient screen.
2. Locate and highlight the specific patient to be moved.
3. Using the Facility Name drop down list, locate the new ‘Facility Name – ID’ of the facility where this patient is to be moved.
4. Click the Save icon to save the Patient.
5. The Decision Message will display.
6. Click the ‘Finish’ button to complete the move.
7. Two (s) Types of Results can occur; review the Patient Summary in the Patient Screen.
   a. Look for the patient that was moved. Because this patient had exported assessments, there will be two (2) rows for this patient:
      i. One (1) row for this patient, which is associated with the original Facility and the Exported assessments AND
      ii. A second row for this same patient associated with the new Facility, having no assessments.
   b. If the Patient to be moved has NO ASSESSMENTS associated with them at the time of the move, then there will only be one (1) row in the Patient Summary. There were no Exported assessments to be associated with the Patient while associated with their original Facility ID.
Assessments

The System Administrator has full access to all features and functionality required for the Assessments.

The Data Entry User has access to add assessments and modify non-exported assessments for those assessment associated with the same Facility with which they are associated.

The View Only User may only view assessments with the same Facility with which they are associated.

The Assessment Screen Layout & Navigation

The IRF-PAI form, reflected in the Assessment screens, has been separated into two (2) Assessment Types within jIRVEN for ease of data entry.

- AD-IRF-PAI Part 1_Admission
- DC-IRF-PAI Part 2_Discharge

For more details see either the QTSO Website:  https://www.qtso.com/cmslinks.html
Or the CMS Website: http://www.cms.gov/Medicare/Medicare-Fee-for-Service-Payment/InpatientRehabFacPPS/index.html

Administration and Assessment Search Tabs

Tabs for any open, but inactive, Administration Screen will display below the toolbar at the top of the screen under the Assessment. In the following screen shot, there are three (3) Administration Screens and the Assessment Search shown.

![Assessment Screen Layout & Navigation](image)

When the Assessment screen is active, no other screen may be accessed.

**Examples:**

When a user tries to view one of the inactive tabs an informational message is displayed. “Stop. < Screen Name> cannot be accessed while an assessment is being edited.”

![Assessment Screen Layout & Navigation](image)

The user will need to click the ‘OK’ button to close the message pop-up window to return to the Assessment screen.
Assessment Data Tabs within the Assessment

There are three (3) tabs directly associated with the Assessment located on the top right side of the assessment screen.

- Assessment
- Patient Details
- Assessment Determination

Assessment Details – Screen Sections
**Navigator**
The Navigator is on the left side of the assessment screen and labeled as such.

The navigator is a collapsible “tree”, which lists all the assessment categories and the assessment questions under each category.

The fields for the questions that require answers are in bold. As questions are answered, they are removed from the tree.

The Show/Hide Answered Questions icon in the toolbar at the top of the screen will also change the display of the tree.

Clicking on an item in the tree will directly place the cursor in the selected field.
**Edits List**

The Edit section is located on the bottom left corner of the assessment screen.

Any errors and warnings will be found in the display area after doing the ‘Save & Validate’. Clicking on an edit message will move the cursor within the assessment to the appropriate field.

Some errors will present a pop up message, during the data entry process, and must be addressed at the time they are displayed, in order to proceed.

**Assessment Tab**

This section lists the assessment questions and answers. This is where assessment data (IRF-PAI Data) is actually entered into the assessment.
Examples shown are:

- Part 1: The first portion under the Admission Assessment allows for entry and displays ‘Admission Information’. It does not display any discharge questions. Admission Date (12) will be read only and will be auto-filled based on the initial creation of the assessment.

- Part 2: Discharge Assessment displays Admission and Discharge questions. The user will be allowed to answer the discharge questions and modify any admission questions with the exception of the Admission Date (12) which will be read only.

**Patient Details Tab**

Patient Detail data is displayed in a Read Only/View Only format. Included on this tab are the same data fields found on the Patient Screen.
Assessment Determination

Assessment Determination data, from the initial Wizard, is displayed in a view only format.

Create an Admission Assessment

To create an assessment the following must already be accomplished or available:

- Successful Login
- Existing Administration Data: Facility, User, and Patient

Assessments are created for Patients. Therefore, a specific Patient must be selected from the Patient screen.

Select a Patient

Complete the following steps to create an Admission Assessment:

1. Select the Patient option from the Administration drop down on the toolbar.

2. The Patient Screen displays.
3. Search for a patient or add a new patient.
4. Highlight the Patient in the summary.
5. Double click on that specific Patient OR click on the ‘Add Assessment’ button.
6. The Add Assessment Wizard Pop-up window is displayed.
The Assessment Wizard

Create a New Unique Assessment

The Wizard is a pop-up window used for creating all assessments.

Complete the following steps to finish creating the assessment.

1. Select the Admissions Date.
2. Select the one Time Period based on the anticipated Discharge date.
   a. ‘Discharge Date Prior to 10/01/2012’
   b. ‘Discharge Date equal to 10/01/2012 thru 09/30/2014’
   c. ‘Discharge Date equal to 10/01/2014 thru 09/30/2015’
   d. ‘Discharge Date equal to or after 10/01/2015.’
3. The Finish button is enabled.
4. Click Finish to continue to the Assessment screen.
5. The Admission Assessment displays.
6. Enter applicable data into the Admission Assessment.
7. Click the Save and Validate icon.

IMPORTANT NOTE: If the incorrect admission date and/or time period are selected, the assessment will need to be deleted and re-entered again through the Wizard. When the two fields have been entered, the assessment type to be completed is calculated and displays in the Assessment Type field. ‘Assessment Type’ is a calculated field. It requires no user input.

Possible Error Situations

Errors and/or warning messages, if applicable, will display in a pop-up screen.

1. Click the ‘OK’ button to return to the Add Assessment screen to make any necessary changes.
2. Click the ‘Cancel’ button to return to the Patient screen.
Error: Created a Duplicate Assessments
If the Next button at the bottom of the Wizard is enabled instead of the Finish button, the information entered on the Add Assessment screen duplicates an already entered assessment.

Either:
1. Highlight the assessment. Click the ‘Finish’ button to continue with data entry of that assessment
OR
2. Click the ‘Cancel’ button to return to the Patient screen.
OR
3. Click the ‘Back’ button to return to the Wizard.

Error - Created an Exported Duplicate Assessment
If the assessment is already in an EXPORTED status, the following message will display, “Error. Duplicate assessment found has a status of EXPORTED and cannot be opened from this window. Please use the assessment search screen.”

1. Click the ‘OK’ button

2. Review using the Assessment Search screen.

Add the Discharge

Select Applicable Admission Assessment
Complete the following steps to add a Discharge.
1. Locate the specific Admission Assessment using the Assessment Search Screen. The status of this assessment must be set to “COMPLETE”.

   IMPORTANT NOTE: You may experience increased wait time when searching for a large number of Residents due to database encryption.

2. Highlight the Assessment required.

![Assessment Search Screen](image)

   NOTE: The Admission Assessment must have a Status of COMPLETE in order to start a Discharge Assessment. To get an Admission Assessment to COMPLETE status, the assessment must have been saved and validated with no error edits.

**Initiate the Discharge**

Double-click on Admission Assessment. Complete the following steps:

1. The ‘Completed Admission’ pop-up window displays. Three (3) Choices are provided.
   a. The default selection is ‘Open this assessment in read only mode,’
   b. “Create a Discharge Assessment.”
   c. “Reset Status and Edit”
2. Select the “Create a Discharge Assessment” option.

3. Click the ‘OK’ button.
   
   Note: Clicking the ‘Cancel’ button will close the pop-up window and return to the assessment search screen.

4. The Discharge Assessment displays.

5. Enter applicable data into the Discharge Assessment.

6. Click the Save and Validate icon.
7. This will populate the CMG section at the bottom of the assessment.
8. Close the assessment.

Data Entry into the Assessment

When the assessment first opens, after the ‘Add Assessment Wizard’ is completed, there are various data fields, which pull their data from the Administration Screens. These are pre-populated and may not be changed within the assessment.

DATA ENTRY TIPS: 1) For optimization of the skip patterns and/or edits, it is recommended that assessment data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results. 2) Enter data in each field and use the “Tab” key on the keyboard to navigate from field to field. This allows skip patterns and edits to be appropriately applied and helps ensure all fields are addressed.

Complete the following steps to complete data entry into the assessment. Data Entry may be completed all in one sitting, or spread out across several.

1. Enter applicable data into the assessment beginning at the top of the Assessment tab.
2. Pop-up edit messages must be addressed as they are displayed before continuing on with the data entry field.
3. Edit Messages, Errors and Warnings
   a. Errors and warnings found on the data, display in the lower left of the screen in the ‘Edit” section of the assessment.

RULES:
1. Error edits must be corrected before the assessment can be completed.
2. Warning edits provide only a warning. It is up to the user to enter the data appropriately. Warning Edits would not stop the assessment from being exported.

   NOTE: For the system to calculate CMG values, the Discharge Assessment must be successfully saved and validated without Error edits.

4. There are two options for saving this data.
   a. Click the Save icon.
   b. Click the Save and Validate icon.

Save

When a ‘Save’ is selected for an assessment, the data is simply saved. It is NOT validated. The status of the Assessment will be set to “IN_USE”. Once the data has been saved, the user may then close the assessment.

   DATA ENTRY TIP: Before closing an assessment and SAVING, always tab forward off the last field entered. This will ensure that that last field is saved.

This assessment may be re-opened at a later time for more data entry or for the ‘Save & Validate’ process.

Save & Validate

Admission Assessments

The following process occurs when ‘Save & Validate’ icon is selected.
1. The VUT will use the Data Specification edits to verify the assessment further.
2. If there are no errors, the admission assessment Status will become ‘COMPLETE’.

   ![Save and Validate assessment](image1.png)

   a. Click the ‘OK’ button.

3. If errors and/or warnings are found, they will be identified and provided in the ‘Edits’ list and the following informational message will display. Status will be ‘DATA_ENTRY’.

   ![Save and Validate assessment](image2.png)

   a. Click the ‘OK’ button.

   IMPORTANT NOTE: The User may elect to continue adding/modifying data in the assessment, and selecting doing the ‘Save & Validate’ until all the errors/warnings have been addressed OR they may choose to simply close the assessment “as is” and it will be saved.

4. Close the Assessment.

**Discharge Assessments**

The following process occurs when ‘Save & Validate’ icon is selected.

1. The VUT will use the Data Specification edits to verify the assessment further.
2. If there are no errors, the discharge assessment Status will become ‘EXPORT_READY’.
   a. Click the ‘OK’ button.
   b. Close Assessment.
3. If errors and/or warnings are found, they will be identified and provided in the ‘Edits’ list and a message will display. Status will be ‘DATA_ENTRY’.
   a. Click the ‘OK’ button.
   b. Close assessment.

**Print Report Directly From the Assessment**

There are two (2) reports that can be initiated from the File options when the assessment screen is open:

- “Print Assessment Report”
- “Print Error Report”
Print Assessment Report

To print the Assessment Report, complete the following steps:

1. Click the ‘Print Assessment Report’ icon on the toolbar. Select the ‘Print Assessment Report’ option from the File Menu item drop down.
2. The Criteria pop-window is displayed. This is used to enter the number of signatures required on the Assessment Report.

   ![Assessment Report Window]

3. Enter the number of Signature Lines required or use the default, which is 12.
4. Click “OK”.

   NOTE: Clicking “Cancel” on the Signature pop-up will close the pop-up and halt the report processing.

The Assessment Report uses the Report Viewer. The Report Viewer displays the report. For details on how to use the viewer is found in the section Report Viewer.

Print the Error Report

To print the Assessment Error Report complete the following steps:
1. Click the ‘Print Error Report’ button below the ‘Edits’ section.

OR

2. Click the ‘Print Assessment Error Report’ icon on the toolbar.

OR


4. The Report Viewer displays the report. For details on how to use the viewer is found in the section Report Viewer.

![Assessment Error Report](image)

**Assessment Error Report**

- **Assessment Type:** AD-NRF-PN Part 1_Admission
- **Assessment Date:** 04-22-2014
- **Last Name:** PLName01
- **First Name:** FFName01
- **Birthdate:** 01-01-1960
- **Admission Date:** 03-31-2014

<table>
<thead>
<tr>
<th>Question</th>
<th>Severity</th>
<th>Error Number</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>Error</td>
<td>-1014</td>
<td>This item is required.</td>
</tr>
<tr>
<td>29A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>30A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>31A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>32A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>34A</td>
<td>Error</td>
<td>-1009</td>
<td>Value must not be blank when item 33A is blank.</td>
</tr>
<tr>
<td>35A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>36A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>37A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>38A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>38A</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39B</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39C</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39D</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39E</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39F</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39G</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39H</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39I</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39J</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39K</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39L</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39M</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39N</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39N</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39O</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
<tr>
<td>39P</td>
<td>Error</td>
<td>-1010</td>
<td>Invalid value for this item. [null]</td>
</tr>
</tbody>
</table>
Editing/Modifying an Assessment

The steps to modify an existing assessment, which must first be opened, depend on the Assessment Status.

Opening an Existing NON-Exported Assessment

Complete the following steps to edit an existing assessment(s) with the following statuses.

- NEW
- IN_USE
1. Search for the required assessment. The details for how to search are in the jIRVEN User Tool Search section.
2. Double-click on the assessment
   OR
3. Click once on the assessment to highlight and click the Edit Assessment button at the bottom of the page.
4. The Assessment screen opens for editing.
5. Edit the assessment if applicable.
6. If changes are made, click the Save and Validate icon on the toolbar.
7. Close the assessment.

Opening an EXPORTED Assessment

Complete the following steps to edit an existing assessment with a status of EXPORTED. Only a user with a System Administrator role may edit an assessment that has been exported.

1. Search for the desired assessment.
2. Double-click on the assessment.
   OR
3. Click once on the assessment to highlight and click the Edit Assessment button at the bottom of the page.

4. User has four (4) options:
   a. ‘Open this assessment in read only mode’
      i. Discharge Assessment opens and displays all previously selected answers from admission and discharge in a view only format. This selection checks the View Only checkbox at the bottom of the Assessment Search screen. All other assessments will be view only until this box is unchecked.
   b. ‘Create a correction record’
      i. Discharge Assessment opens and displays all previously selected answers from admission and discharge. All fields are editable except the Admission Date (12) and Discharge Date (40). Correction number increases by 1.
   c. ‘Create an inactivation record’
      i. The Inactivation Assessment opens. All fields are a view only format. The Assessment Type has been changed to XX-IRF-PAI Inactivation. Correction number increases by 1.
   d. ‘Reset Status and Edit’
i. Discharge Assessment opens and displays all previously selected answers from admission and discharge in an editable format. All fields are editable except the Admission Date (12). Correction number does not change.

5. Edit the assessment, if required.
6. If changes are made, click the Save and Validate icon on the toolbar.
7. Close the assessment.

**Copying an Inactivated Assessment**

Complete the following steps to copy an inactivated assessment with a status of EXPORTED. These will start with an Assessment Type of XX-IRF-PAI Inactivation. Only one copy per inactivated assessment is allowable.

1. Search for the required assessment.
2. Double-click on the assessment OR
3. Click once on the assessment and click the Edit Assessment button at the bottom of the page.

4. User has three (3) options
   a. ‘Open this assessment in read only mode’
      i. Inactivation Assessment opens and displays fields in a view only, non-editable, format. This selection checks the View Only checkbox at the bottom of the Assessment Search screen. All other assessments will be view only until this box is unchecked.
   b. ‘Create a copy record’
      i. A new Discharge Assessment opens and displays all previously selected answers from the inactivated record. The correction number of this assessment will be 00. All fields are editable except the Admission Date (12). If a copy has already been made from this inactivation assessment, this option will not be available.
   c. ‘Reset Status’
      i. Inactivation Assessment opens and displays all applicable fields in a view only, non-editable, format. The status of the assessment is also reset to either Export Ready (if assessment was Saved and Validated and is without errors) or In Use (if assessment was closed without saving).

5. Edit the assessment.
6. Click the Save and Validate icon on the toolbar.
7. Close the assessment.
Viewing an Assessment in View Only Mode

Complete the following steps to open an assessment in view only mode.

1. Search for the desired assessment using the User Tool Search. This is detailed in the jIRVEN User Tool Search section.

   Please Note: You may experience increased wait time when searching for a large number of Residents due to database encryption.

   ![Image of jIRVEN Assessment Search](image)

1. Check the View Only checkbox at the bottom of the screen. (This is only available for the System Administrator and Data Entry User. A View Only user only has the option to open assessments in View Only mode.)

   OR

2. Double-click on the required assessment.

3. Click the ‘View Assessment’ button at the bottom of the screen.

4. The Assessment screen opens in view only mode.

   View Only TIP: An assessment in view only mode cannot be modified. If this assessment is closed and the user tries to open another assessment from the Search screen, it will be displayed as view only also UNLESS the user unchecks the View Only check box before opening the next assessment.
Close the Assessment

TIP: Before closing an assessment always tab forward off the last field entered. This will ensure that the last field is saved.

Close the assessment by:
1. Click the ‘X’ on the corner of the Assessment Tab.

OR
2. Click the ‘Close Assessment’ option under the File Menu.

OR
3. Click on the Tool Bar icon.

Deleting an Assessment

RULES:
1. Only a user with a System Administrator role may delete an assessment.
2. Assessments with a status of EXPORTED cannot be deleted.

Complete the following steps to delete an assessment.
1. Search for the desired assessment using the Assessment Search
2. Click once on the required assessment. Click the ‘Delete Assessment’ button at the bottom of the Assessment Search screen to delete the selected assessment.
3. The “Confirm Assessment Delete” message displays.
4. Click OK to delete the assessment.

   NOTE: Clicking Cancel will close the message and not delete the assessment.

5. An informational message confirming the delete displays, “Delete Assessment. The Assessment has been deleted.”
Special Functionality

Administration Screen Data Has Changed

When the Administration Data is modified AND it is associated with an assessment, it will not be reflected in that assessment at the time the data was actually modified using an Administration Screen. Only when the assessment is opened by a user with access to update an assessment, in the edit mode, will the user be asked if they wish to have that assessment updated with the new data. Updates from the Administrative Screen will be automatically updated on the Assessment Search screen, and do not necessary reflect the current information in the assessment.

If the user says, “yes”, then the application will pull the administration data into the assessment.

NOTE: The User will continue to get this Decision Message until the user answers it with the “Yes” option.

Facility

The Facility data fields, affecting the Assessment, are reflected on the Facility Details tab on the Assessment screen. When this facility data is changed, the following message will be displayed, “Decision Message: Facility Date Updated. “The facility information has changed, would you like to update the assessment to reflect these changes?”

Patient

The Patient data fields, affecting the Assessment, are reflected on the Patient Details tab on the Assessment screen. When this patient data is changed, the following message will be displayed, “Decision Message: Patient Data Update. The patient information has changed, would you like to update the assessment to reflect these changes?”
User
The User, when terminated using the Termination Date on the Administration User Screen, will display a message, “An assessment associated with a terminated User ID will update to an active User ID when an active user opens an assessment.”

Exporting Assessments for Submission into ASAP
The Export Assessments screen allows the user to export assessments and to view what assessments have been exported. Select the Export option from the Import/Export drop down on the toolbar.

New Exports
Complete the following steps to export ‘New Export’ assessment(s).
1. The Export Assessments screen displays.
2. Select the Export Type of ‘New Export (Assessments marked as “Export Ready”)’.
3. Select the Submission Type
   a. Product Submission
4. Select the Export Path. This field is required. This is the location where the exported files will be stored. Click on the Browse button to navigate to the location where the files will be exported.
5. Select the Export Name. This field is required. Enter a unique file name for the export file.
   a. The file type must be .ZIP (XML)
6. Select the Export Description. This field can be used to document details regarding the export.

7. Select the checkbox next to the Patient Name to be included in the Export. A list of assessments available to be exported is displayed. A minimum of one selection is required. The assessments must be in “Export Ready” status to display in this list.

   a. The Select All button will select all assessments displayed in the list to be included in the export file.
   b. The Clear Selection button will unselect all assessments previously selected.

2. If desired, select the Print Assessment List button to print a list of assessments included in the file to be exported.

8. Select the Error Check button to validate and/or check for errors on all previously selected assessments. Error results display in a new screen.
a. Select the Save to File button to save the error report (.txt)
b. Click the ‘X’ in the top right corner to close the report.

9. Select the Export button to export selected assessments for submission.
10. The Export complete message displays to notify the user the process is complete. Included are:
   a. The location of the exported files displaying in parenthesis at the end of the message.
   b. The total number of assessments exported.
11. The files are ready for submission to the national database.

**Previous Exports**

Complete the following steps to export ‘Previous Export’ assessment(s).

1. The Export Assessments screen displays.
2. Select the Export Type of ‘Previous Export (Assessments marked as “Export Ready” or “Exported”)’.
3. Select the Submission Type
   a. Product Submission
4. Select the Export Path. This field is required. This is the location where the exported files will be stored. Click on the Browse button to navigate to the location where the files will be exported.
5. The Export Name field will be auto-filled with the Export Name of the original exported (Previous Exports only)
   a. This field is required.
   b. User may override the auto-fill.
   c. The file type must be .ZIP (XML
6. Select the Export Description. This field can be used to document details regarding the export.
7. Select/highlight a previous export in the Previous Exports section.
8. A list of assessments that were exported in the selected file is available to be exported again, and is displayed in the Previously Exported Assessments section. A minimum of one selection is required.

9. Select the checkbox next to the Patient Name to be included in the Export.

10. Select the ‘Export’ Button.

11. To select all the previously exported assessments, or to clear all the check marks already used, use the following action buttons:
   a. The ‘Select All’ button will select all assessments displayed in the list to be included in the export file.
   b. The ‘Clear Selection’ button will unselect all assessments previously selected.

12. If desired, select the Print Assessment List button to print a list of assessments included in the file to be exported.

13. Select the ‘Error Check’ button to validate and/or check for errors on all previously selected assessments. Error results display in a new screen.
14. Select the ‘Save to File’ button to save the error report (.txt)
15. Click the ‘X in the top right corner to close the report.
16. Select the ‘Export’ button to export selected assessments for submission.
17. The Export complete message displays to notify the user the process is complete and how many assessments were exported.
18. The location of the exported files displays in parenthesis at the end of the message.
19. The files are ready for submission to the national database.

**Import Data From Outside Source**

The Import Assessments screen allows the user to determine how data is imported. Please Note: You may experience increased wait time when importing a large number of Patients due to database encryption. Only System Administrators can import patients and assessments.

Complete the following steps to import an assessment.

1. Select the Import option from the Import/Export drop down on the toolbar.

2. The Import Assessment screen displays.
3. Select the Location. Click on the Browse button to navigate to the location of the files to be imported.
4. Set Preferences.
   a. Patient Data Options Checkbox
      i. “Do not give warning when new patient is added during import.”
         1) Selecting this box turns off the warning message displayed when a new patient is imported.
         2) Leaving this box unchecked, results in being notified each time a patient is not matched to one in the database.
            a. Yes = Add patient to the database
            b. No = Do not import the patient into the database or any associated assessments,
            c. Cancel = Stop the import process.
   b. Miscellaneous Data Options Checkboxes
      i. “Do not display warnings in error check results.”
1) Removes warning messages from the error check results report that displays after importing data. Only fatal errors are included in the report.

ii. “Assign Exported status to assessments without errors (instead of Export Ready.)”
   1) Sets the status of imported assessments to Exported, if the record does not have errors.

iii. “Associate assessments with a blank FAC_ID field to the selected facility below.”
   1) Links assessments that are imported without a Facility ID to the facility highlighted in the Associate assessments with blank Facility ID’s to this facility section.

c. Click the Select All Options button to check or uncheck all checkboxes. This button will change to Deselect Options button, which will uncheck all checkboxes.

5. Select the Error Check button to validate and/or check for errors on all assessments to be imported. Error results display in a new screen.
   a. Select the Save to File button to save the error report (.txt).
   b. Click the X in the top right corner to close the report.

6. Click the Import button to import selected assessments into jIRVEN.

7. A New Patient message displays.
   a. Click Yes to continue with the import of the assessment.
   b. Click No or Cancel to stop the import process.

8. A Progress Information message displays. This process loads the submission data specifications to be used by jIRVEN for data validation of assessments during import. The assessments are compared to the submission edits.

9. An Import complete message displays, “Import is complete. <<number of assessments>> imported.”, as well as a Status Report for all assessments included in the import.
a. If no files are successfully imported, the Import failed message box displays, “No assessments appear to have passed import.” along with a Status Report.

10. Click the ‘OK’ button on the Import Complete box to view the Status Report.

11. Click on the ‘Save to File’ button, on the bottom of the report, to save a copy of the report.

12. Click on the X in the top right corner to close the report.
jIRVEN Application Reports

jIRVEN reports allow users to preview and print assessment information, as well as detail and summary information for both facilities and patients.

Report Viewer

The jIRVEN application reports are generated in third-party software, Report Viewer, using this software’s ICONS and formatting. All the reports use this software in the same fashion.

Print Report

To print the report, click the Print icon on the Report Viewer screen.

Save Report

To save the report, click the Save icon on the Report Viewer screen.

Export Report

To export a report, click the arrow next to the Save icon. The available export values display.

To select an export type, use the dropdown arrow by the Save icon to select a location to export (save) the report and click ‘Save’.

Available Reports

Available jIRVEN Reports are listed under the Menu Item ‘Reports’.

- Event Tracking
  - Assessment Data
  - Facility
  - Patient
  - User

- Assessment Data Entry – By Status

Event tracking Reports

Complete the following steps to run the Event Tracking report.
IMPORTANT NOTE: Only the System Administrator User ID can run the Event Tracking reports.

1. Select Event Tracking from the Reports drop down on the toolbar.

2. The Event Tracking criteria screen displays.

3. Complete all the fields on this “Event Tracking” Criteria window.
   a. Event
   b. Data Entry Date Range

4. Select the ‘OK’ button to generate the report.

   NOTE: Selecting the ‘Cancel’ button will close the parameter screen; no report will be generated.

5. The Report Viewer screen opens displaying the generated report.

**Facility Event Tracking Report**

1. Select ‘Event Tracking’ from the Reports drop down on the toolbar.
2. The Event Tracking criteria screen displays.
3. Complete all the fields on this “Event Tracking” Criteria window.
   a. Event = Facility
   b. Data Entry Date Range

4. The Report Viewer screen opens displaying the generated report.
5. The data fields included on this report are:
   a. Event Type,
   b. User ID
   c. Event Date
   d. Facility Name
   e. Facility City
   f. State
   g. Assigned ID

**User Event Tracking Report**

1. Select Event Tracking from the Reports drop down on the toolbar.
2. The Event Tracking criteria screen displays.
3. Complete all the fields on this “Event Tracking” Criteria window.
   a. Event = User
   b. Data Entry Date Range
4. The User Event Tracking report will display. The fields included on the report are:
   a. Event Type
   b. User ID
   c. Event Date
   d. Login ID
**Patient Event Tracking Report**

1. Select “Event Tracking” from the Reports drop down on the toolbar.
2. The Event Tracking criteria screen displays.
3. Complete all the fields on this “Event Tracking” Criteria window.
   a. Event = Patient
   b. Data Entry Date Range
4. The Report Viewer screen opens displaying the generated report. The data fields included on this report are:
   a. Event Type,
   b. User ID,
   c. Event Date
   d. Last Name,
   e. First Name
   f. SSN,
   g. Birth Date
   h. Hide Patient Flag

Assessment Event Tracking Report

1. Select Event Tracking from the Reports drop down on the toolbar.
2. The Event Tracking criteria screen displays.
3. Complete all the fields on this “Event Tracking” Criteria window.
   a. Event = Assessment Data
   b. Data Entry Date Range
4. The Report Viewer screen opens displaying the generated report. The data fields included on this report are:
   a. Event Type,
   b. User ID,
   c. Event Date
   d. Last Name,
   e. First Name
   f. SSN
   g. Assessment Type,
   h. Assessment Date
Assessment Data Entry – By Status Report

Complete the following steps to run the Assessment Data Entry – By Status report.

**NOTE:** All User Roles can run this report.

1. Select Assessment Data Entry – By Status from the Reports drop down on the menu bar.

2. The Assessment Data Entry – By Status criteria screen displays.
3. Select the Facility.
4. Select Status.
   a. To select all status items, hold the SHIFT button while you select or scroll through the list.
   b. To select a few status items, hold the CTRL button while you select statuses to display on the report.
   c. Only one status is required.
5. Enter ‘From’ and ‘To’ dates.
6. Select the ‘OK’ button to generate the report.

   Note: Clicking the ‘Cancel’ button will close the criteria report pop up and not open the Report viewer.

7. The Report Viewer screen opens displaying the generated report. Data Field on the report are:
   a. Patient Name: Last Name, First Name
   b. SSN,
   c. Gender,
   d. Birth Date
   e. Assessment Type,
   f. Assessment Date
   g. User (ID)
Closing the Application

Session Time Out

To assist with keeping data secure in jIRVEN, if at any time during data entry there is no activity by the user for 10 minutes, the system will display a timeout message, “Session Time Out will occur at <<time>>. Do you wish to cancel the Session Time Out?”

To continue with the session, the user may click OK. If the user does not click OK before the time displayed on the pop-up, the user will be logged out of jIRVEN and the login screen will be displayed.
Logout

To log out and return to the login screen, select the Logout option from the Security drop down on the menu bar.

This allows the user to log into the application again or another user to login.

Exit

To close jIRVEN, select the Exit option from File drop down on the menu bar.

jIRVEN can also be closed by selecting the red ‘X” icon in the top right corner of the screen.

Data Backup on Close

jIRVEN creates a backup of the database when the application is closed following an active session. Complete the following steps to close and backup data.

1. Select the ‘Exit” option from the File drop down on the menu bar or the X in the top right
2. The Backup jIRVEN Database message displays.
3. Choose one of the following options.
   a. Click Yes to back up the database and close jIRVEN.
   b. Click No to not backup the database and close jIRVEN.
4. Informational messages display during the backup.

![Backup JIRVEN Database dialog box](image)

5. When the backup has been closed, one of the following messages will be displayed.
   a. “Backup procedure was completed successfully.”
   b. “Backup procedure was canceled.”
   c. “Backup procedure has failed.”

![Database Backup popup windows](image)

6. Click the ‘OK’ button.
7. The application closes.

**IMPORTANT NOTE:** If, however, a backup has not occurred within the last 7 days of this active session, the jIRVEN system will not display the above question (steps 2-4). Instead, the system will automatically backup the database when closing this session.

The status of the completed backup will be displayed in another pop-up window providing the status of the completed backup.
NOTE: To restore the database from a prior backup copy, see the details in the section Restore the Database from Backup.

Security

All User Roles have access to the Security Menu Bar selection. The available options are:
- Change Security Answers
- Change Password
- Logout

Change Security Answers

Complete the following steps to change your answers to your security questions:

1. Login to jIRVEN.
2. Select Security from the File Menu.
3. Click on the Change Security Answers option. A pop-up window will be displayed, which requires the confirmation of the users’ current password.
4. Enter the password.
5. Click ‘OK’ button.
6. The ‘Security Questions’ pop-up window displays.
7. Enter at least six (6) answers AND tab forward.
   a. “What city were you born in?”
   b. “What year did you graduate from high school?”
   c. “What is your favorite sport?”
   d. “What was the make of your first car?”
   e. “What was the color of your first car?”
   f. “What is your mother’s maiden name?”
   g. “What was the name of your first pet?”
   h. “What size shoe do you wear?”
   i. “What is your favorite season of the year?”
   j. “What is your favorite movie?”

Note: Clicking the ‘Cancel’ button will end this process.
8. Click ‘OK’ button.
9. The window is closed and the new answer(s) is saved.

**Change Password**

User passwords may be changed at any time. However, all Users will be asked to change their passwords every 60 days. Complete the following steps to change a password.
1. Login to jIRVEN.
2. Select the ‘Change Password’ option from the Security drop down on the toolbar.
3. The ‘Change Password’ screen displays.
4. Enter the current password in the “Password” text field.
5. Enter a new password in the “New Password” text field.
6. Enter the new password again in the “Confirm New Password” text field.

   IMPORTANT NOTE: The two passwords must be exact matches and must follow the password rules. Detailed in section Password Rules.

7. Click the ‘Change Password’ button.

   Note: Clicking the ‘Cancel’ button will not change the password and end this process.

8. The pop-up window closes and the new password is saved.

Help

Help documents are available for all data entry fields and assessment questions.

While performing data entry, the help documents can be accessed by clicking on the Help icon to the right of each field/question. After clicking on the Help icon, a pop-up window will display the information describing the field.

This feature is available on the Administration Screens. The sample shows the Help icons on the Facility Screen.

Help Options from Menu Bar

Help information can also be accessed by selecting one of the options from the Help dropdown on the Menu Bar. Available Options for selection are:

- Search
- Help Content
- About Quality Management System
- Home Screen
Help Search

1. Select the ‘Search’ option, which allows input of a specific topic in the ‘Search expression’ field.

2. Enter the topic for the search.
   a. ‘Assessment’ is used in example.
3. Click ‘Go’ button.
4. The system will display all related options.
5. Click on the options lists
   b. ‘Add Assessment’ is used in example.
6. The list of further selections will display.
7. Click on one of the data fields.
   c. "Assessment Type" was used in first example.
   d. "Time period" was used in second example.
8. The definition of the field displays
   e. Click on the back arrow to make another selection.

9. To return to the original options, click on ‘Search’.
10. Click on another option.
OR
11. Enter a new word in the search field.
12. Click on the help tab ‘X’ to close the Search Help option.
Help Contents

1. Select the ‘Help Content’ option from the “Help” drop down menu, which provides drop down index lists, from which the user may select the topic they require.

2. Clicking the bold “jIRVEN – IRF-PAI 1.1” in the left-hand panel, will display ALL help documents for the most current version of jIRVEN.

3. Click on Facility City to read the definition of this term.
NOTE: Expanding the ‘jIRVEN’ topic and then the ‘jIRVEN Item Help by Timeline’, on the left, will allow the user to narrow the list down to a more specific set of items. In the sample below, only the documents for Facility Screen display.

4. Narrow down the search by clicking on one of the expanded items.
About Quality Management System

Information about the version of jIRVEN currently installed can be found by selecting About Quality Management System from the Help Menu Options.

This selection will display an informational screen.

QIES Help Desk

The QIES Help Desk is available for technical support and assistance with problems or questions that may arise regarding the jIRVEN software.

Contact information for the QIES Help Desk:
1-800-339-9313 or help@qtso.com
Feature Verification

This identifies either the Standalone installation or the Client/Server installation.

Feature Label (jIRVEN) and Feature Version (1.x or 1.x.x) display in the lower left side of the screen. Help Desk Information displays on the right side of the screen.

When the jIRVEN application is accessed and the computer running jIRVEN has an internet connection, the application will compare the version currently installed with the version available on the QIES Technical Support Office (QTSO) website. If a new version of jIRVEN is available, a message will display directing the user to the QTSO website to download the latest version.

Home Screen

Select the ‘Home Screen’ option, which opens the Home tab or if already opened, will display the Home tab to the front view.

Clicking the Home Screen option here will turn on the display again, but only for this specific session.

To change the setting for the Home Screen to be turned on permanently, the User must check the check box at the bottom of the Home Screen in front of the sentence “Do not display this home screen after logging into the application.”
Misc. System Maintenance

Passwords

Password Rules
Passwords are case-sensitive. The following rules are displayed at the top of the Change Password screen:

- The new password and the confirm new password must match.
- The new password must be at least eight (8) characters long.
- The new password must be no more than 20 characters long.
- The new password must not contain any space.
- The new password must not contain the User ID, First Name, Last Name, or Email.
- The new password must not begin with a number.
- The new password can only contain a maximum of Three (3) repetitive characters.
- The new password must contain at least one for each of the following type of characters.
  - Upper-case Character: A-Z
  - Lower-case Character: a-z
  - Number: 0-9
  - Special Character: - &~'*@#%^*()_+={}\|:;''',<>,.?/

The new password must not match any of the user’s most recent Six (6) passwords. The new password will be set to expire in 60 days.

Forgotten Passwords
Complete the following steps:
1. On the login screen, enter User ID and click the ‘Forgot Password’ button.

2. The ‘Security Questions’ pop-up window displays.

3. Answer all the security questions.
4. Click the ‘OK’ button to continue to the Change Password screen.

Note: Clicking the ‘Cancel’ button will return to the login screen.
Locked User Accounts

Data Entry User & View Only User Account Locked
The following message will display if a user account becomes locked.

User may either:
- Follow the instructions for Forgotten Passwords to unlock the account. Security questions must be answered and a new password must be created to continue.
- The System Administrator can reset the account following these steps:
  1. The System Administrator must log in.
  2. On the User screen, select the user that has a locked account (displays in bold in the User Summary section).
  3. On this User screen, check the ‘Reset Password/Unlock the Account’ checkbox.
  4. Click the ‘Save’ icon.
  5. The user account is unlocked with the password reset to the User ID.

System Administrator Account Locked
If a System Administrator account becomes locked, the same message will display.

Follow the instructions for Forgotten Passwords to unlock the account.

Security questions must be answered and a new password must be created to continue.

IMPORTANT NOTE: A second System Administrator may log in and reset the account by following the steps as described above.

Help Desk to Unlock Account
If the account cannot be unlocked using one of the methods above, contact the QIES Help Desk for assistance. Contact information is in the section QIES Help Desk.

Database Backup
Database backup occurs automatically on a regular basis.
See the section Data Backup on Close for the details of this backup process.

The jIRVEN application will also automatically back up the database if it has NOT been backed up in the last 7 days.

Changing the Backup File Location

To change the location used when the jIRVEN database is backed up, use the File Menu dropdown; select ‘Change Backup Location’.

The default location for the backup database is located in a workspace\database\backup folder where the application is installed. Only System Administrators may change the location where the backup will be stored. Complete the following steps to change the location where the backup will be stored.

1. Select the ‘Change Backup File Location’ option from the File drop down from the menu bar.
2. The Change Backup File Location window displays with the current backup location highlighted.
3. Select the desired backup location using the scroll bar

OR

4. Create a new folder using the ‘Make New Folder’ button.
5. Click ‘OK’ button to set the location and close the screen.

Note: Clicking the ‘Cancel’ button will close the window without changing the location of the backup files.

Restore the Database from Backup

In the event of data loss, System Administrators may perform a database restore from a prior database backup.

A database restore requires the assistance of the QIES help desk (1-800-201-339-9313 or help@qtso.com).

You must know the verification information before calling the Help Desk. Use the following steps to locate these features.

1. Click the ‘About Quality Management System’ under the Help Menu.

2. The ‘About Quality Management System’ screen displays.
3. Locate the verification features in the lower left-hand corner of the ‘About Quality Management System’ screen.

   a. Installation Type
   b. Feature Label:
   c. Feature Version
   d. Feature ID
   e. Build ID Number

4. Call the QIES help desk (1-800-339-9313 or help@qtso.com).
Unlock Network Client/Server Records

In the Network Client/Server version of jIRVEN, multiple users access a central database. When this functionality is provided, it is necessary to provide additional safe guards to keep multiple users from trying to open and use the same records at the same time. The system will lock a record once a user opens it for edit.

The System Administrator is the only user who can, if necessary, unlock records.

NOTE: Only System Administrators have access to this button. It is disabled for all other User Roles. This is only available in the Network Client/Server version of the application. The number of Users assigned to the System Administrator user role should be kept at a minimum for control purposes.

Unlocking an Assessment from the Assessment Search Screen

The action button on the bottom of the Assessment Search screen can be used by the System Administrator to unlock an assessment.

1. The System Administrator locates the locked assessment(s) by locating the assessment in the Assessment Summary with an entry in the ‘Locked’ column.

OR

2. Using the option to select only locked records
3. The System Administrator may then highlight the locked assessment(s) and click on the ‘Unlock Assessment’ button.

4. This process unlocks the assessment.

NOTE: If the previously user did NOT save any work done, it will be lost.
End of jIRVEN User Guide

Version 1.2.0